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Accounts Payable Guide

Purpose of Guide

This Accounts Payable Guide covers the process of data entry and day-to-day tasks in the Tabs3
Accounts Payable Software, including creating vendors, entering invoices and manual checks,
printing checks, and posting checks.

The Administrator Guide includes instructions on initial setup and configuration of the Accounts
Payable software, including customization, bank accounts, where to purchase checks, and check
printers.

The Integration Guide covers information related to integration between Tabs3 and PracticeMaster
products and provides initial configuration information. Additional information related to
integration is available throughout the Tabs3 and PracticeMaster documentation, particularly the
built-in help feature in the software itself.

All guides are available on our Web site at:

Tabs3.com/support/docs.html

Introduction

Tabs3 Accounts Payable Software (APS) is a comprehensive system designed for use by professional
firms. The system will generate checks for up to 99 different bank accounts and information for IRS
Form 1099 for year-end processing. Invoice transactions can be entered as recurring transactions,
which saves you from having to reenter the same payable information each month. You also have
the ability to enter information for checks that were written manually.
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Bank Accounts

Menu: File | Open | Miscellaneous
Home: All Actions | Setup | Bank Account Entry

Checks are paid from one of up to 99 different bank accounts. The Bank Account window is used to
configure these accounts. This window is also used to configure General Ledger account integration

and which Nelco check layout to use.

Lo & ]

B Bank Account

Bank Account Recurring Entry

Bank Account #: v inactive

Description: | First Bank

Last Check #:
GLS Accounts

Cash Account #: 1110.00 | v  Operating Account
Accounts Payable Account #: 228000 | v Accounts Payable

Check Layout

® Nelco Check Layout L1445
[ automatically switch to Nelco Check Layout L1572

O Melco Check Layout L1572

Figure 1, Bank Account window

More Info: For more information on configuring Bank Accounts, see the APS Help or the

Administrator Guide.
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Vendors

Menu: File | Open | Vendor
Home: All Actions | Vendor | Vendor Information

Vendors are business entities or individuals to whom checks will be paid. Examples of vendors
include the county Clerk of Court or your local office supply company. The Vendor file is used to
add, change, and delete vendor information from the Accounts Payable Software.

Vendor Information EI@
Vendar: | 202 | v [inactive
Name (Last,-’F\rst):| Software Technology, LLC | CHANGE

Name Search: |TAES3 |

Address: 1621 Cushman Drive Details
Lincoln NE 68512

Federal ID #: I:I 1098 Info: | None ~

Contact Name: | Accounts Payable | Vendor Account #: |T34DDDD |

Email: | sales@tabs3.com | Phone: |4D2-419-22DD |

Discount %: Disc Days: O Grace Period: 0 Due Days:
Miscellaneous Vendor [Jone Check per Invoice Activity...

Figure 2, Vendor Information

Many of the fields in the Vendor file are self-explanatory. Those fields that require additional
explanation are listed below.

Vendor The Vendor field is used to store a unique identifying
number for each vendor.

Name Search The Name Search field allows you to run searches by
vendor name rather than vendor number. It is also used to
print reports in alphabetical order.

1099 Info The 1099 Info drop-down box determines whether or not
a 1099-MISC form will print for this vendor and the box in
which information will print on the 1099-MISC form.

Discount % The Discount % is used to enter a discount of up to
99.99% granted by vendors for early payment.
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Disc Days The Disc Days field is used to enter the number of days the
vendor allows a discount to be taken for early payment.

Grace Period The Grace Period allows you to enter a number of days
beyond the Discount Date that you want to take a
discount.

Due Days The Due Days field is used to enter the number of days

you have to pay an invoice.

Miscellaneous Vendor The Miscellaneous Vendor field is used to designate a
vendor or multiple vendors as a "miscellaneous” vendor to
be used for one-time vendor records. This helps to keep
the number of vendors in the vendor file at a manageable
level. Typically only a single miscellaneous vendor is
defined.

One Check per Invoice The One Check per Invoice check box determines whether
or not multiple invoices can be printed on the same check
for the same vendor. If this option is selected, a single
invoice will print on a single check.

More Info: Complete definitions of all fields in the Vendor file can be found in APS Help.

Before you can begin entering invoices, you must configure at least one vendor.

» To add a new vendor

1. From the APS menu, click on File menu, highlight Open, and then select the Vendor option.

|
Click to assign a new vendor number.
Enter the remaining information for the vendor.

M wn

Click B8 to save the new vendor.
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Invoices & Manual Checks

Menu: File | Open | Invoice/Manual Checks
Home: All Actions | Invoices | Invoice/Manual Check Entry
All Actions | Checks | Invoice/Manual Check Entry

Invoice vs. Manual Check vs. EFT

An invoice is a bill received for goods received or services rendered. APS uses the invoice file when
generating checks. When entering invoices, the Check # and Date Paid fields are generated at the
time the check is printed. APS uses the invoice file when generating checks.

A manual check is a check written or generated by means other than Accounts Payable Software.
Typically, manual checks are handwritten by someone at the firm prior to being entered into APS.
When entering manual checks, the Check # and Date Paid fields are entered during the data entry
process.

An EFT is a electronic transfer of funds used to pay an invoice. When entering EFTs, the Date Paid
field is entered during the data entry process.

Invoices, manual checks, and EFTs are all entered using the Invoice/Manual Checks program.

Data Entry

Invoices, manual checks, and EFTs are entered via the Invoice/Manual Checks program. The
Invoice/Manual Checks icon appears on both the Invoices and Checks group of the APS Home
page and Task Folders.

« Selecting the icon from the Invoices group will ensure that you are entering an invoice by
automatically selecting the Unpaid Invoice option.

« Selecting the icon from the Checks group will ensure that you are entering a manual check
by automatically selecting the Manual Check option.
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[ Invoice/Manual Check Entry

E= Quick Print E

Invoice/Manual Check  General Ledger

Vendor: | 700 v

Clean All Janitorial Services
Rural Route 1

P.O. Box 21

Waverly NE 68498
CHANGE

Reference:

Invoice Date: | 10/26/2018 ~
Invoice Amount: 750.00

Memao: | | 0@Unpaid Invoice !' (O Manual Check OFEFT

Description: | Manthly Cleaning Charges (Bi-Weekly Service)

Additional Information

Due Date: 11/26/2018 | v Discount Amount:
Voucher # AUTO Discount Date:
Amount to Pay: 750.00 MNet Amount: 750.00

Take Discount

Payment Information

Bank Account: lz‘ w  First Bank

Chedk #: To Be Printed Date Paid: | mmy/dd/y;

Haold/Pay: P - Pay ~

User ID: | CHERYL ~
Date Entered: 3/2018 ]

[JExclude from 1099 Reporting

Amount Paid: | 0.00

Invoice/Manual Check Entry List Vendor: 700 Clean All Janitorial Services

&

|Hef L Invoice # Description

Check # Inv/Chk Date Inv/Chk Amt ~

1 Monthly Cleaning Charges [Bi*weekly Service]

26646 10/26/2018 780.00

75

Amount: 1,500.00

Figure 3, Example of an Invoice
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[ Invoice/Manual Check Entry

B8 = 4]

Invoice/Manual Check  General Ledger

Vendor: | 200 v Reference:

United Parcel Service Invoice Date: | 11/26/2018 ~

55 Glenlake Parkway, NE
Atlanta GA 30328 Invoice #: | 3243387

CHANGE Invoice Amount: 75.00

i

Mema: | Unpaid Invoice EFT

Description: | Overnight document delivery

Additional Information

Due Date: 11/28/2018 v Discount Amount:
Voucher #; |:| Discount Date; | mm/dd/yyyy Hold/Pay: [P - Pay

MNet Amount: 73.00 User ID: | (BLANK) w
Take Discount Date Entered: | 11/26/2018 w

Payment Information
Bank Account: First Bank Exclude from 1099 Reporting

Check #: 25654 Date Paid: | 11/26/2018 v Amount Paid: | 75.00

Figure 4, Example of a Manual Check
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Invoice/Manual Check Entry EI@
4]

Invoice/Manual Check  General Ledger

Vendor: | 325 v Reference: 7
Professional Messenger Services Invoice Date: | 11/26/2018 ~

8418 Old Cheney
Lincoln NE 68526 Invoice #:

CHANGE Invoice Amount:

Memo: | Unpaid Invoice Manual Check EFT

Description: | Courier Fee

Additional Information

Due Date: v Discount Amount:
Voucher #; |:| mmy/dd/yyyy Hold/Pay: P - Pay
Net Amount: 35.00 User ID: v
Take Discount Date Entered: v

Payment Information

Bank Account: v First Bank Exclude from 1099 Reporting

Check #: EFT Date Paid: | 11/26/2018 v Amount Paid: | 35.00

Figure 5, Example of an EFT

Invoice, Manual Check, and EFT entry are very similar. Those fields that are not self-explanatory or
differ depending on the type of entry being created are explained below.

Reference The Reference field is used as a unique identifier for each
invoice entered for an individual vendor. Press Enter to
add a new entry.

Memo The Memo field allows information required by the vendor
to be printed on the check itself. If Print Memo on Checks
is enabled in Check Setup, then the contents of this field
will print in the Memo line in the lower left corner of the
check. This field does not print on the check stub or any
reports.

Transaction Type The Transaction Type options are used to distinguish
between whether you are entering an Unpaid Invoice, a
Manual Check, or an EFT.

Description The Description field prints on the check stub and reports.
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Hold/Pay The Hold/Pay field determines the payment status of the

invoice. Manual checks cannot be placed on Hold.

Amount to Pay The Amount to Pay field is used when you are paying a

partial amount of an invoice instead of the full amount.
The Amount to Pay field is only available for an unpaid
invoice.

Check # Enter the Check # used for the manual check. The Check #

field cannot be edited for unpaid invoices. Instead, it is
automatically populated when checks are printed. The
Check # field is not available for EFTs.

Date Paid Enter the Date Paid for the manual check or EFT. For

unpaid invoices, the Date Paid field cannot be edited.
Instead, it is automatically populated when checks are
printed.

» To add a new invoice

1.

o A w DN

From the APS menu, click the File menu, highlight Open, and then select the Invoice/Manual
Checks option.
In the Vendor field, select the desired vendor.

Click L to enter a new invoice.
Select the Unpaid Invoice transaction type.
Enter the desired information for the invoice.

Click H to save the new invoice.

» To add a new manual check

1.

o LA W N

From the APS menu, click the File menu, highlight Open, and then select the Invoice/Manual
Checks option.
In the Vendor field, select the desired vendor.

Click L to enter a new manual check.
Select the Manual Check transaction type.
Enter the desired information for the manual check, including the Check # and Date Paid.

Click [:_J to save the new manual check.

» To add a new EFT

1.

From the APS menu, click the File menu, highlight Open, and then select the Invoice/Manual
Checks option.
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In the Vendor field, select the desired vendor.

Click LI to enter a new EFT.
Select the EFT transaction type.

Enter the desired information for the EFT, including the Date Paid.
[=]
Click to save the new EFT.

o v~ w N

Detail vs. Rapid Mode

Data entry can be performed using either the Detail or Rapid entry modes. Click the button on
the Data Entry Toolbar to toggle between Detail and Rapid mode. These modes determine which
fields will be displayed during the data entry session. Detail mode shows all fields on the entry
window, while Rapid mode simplifies the data entry process by masking all but the most pertinent
fields from view. This useful feature allows for fewer keystrokes and faster data entry.

Integration with Tabs3 General Ledger and Tabs3 Billing
If you are integrating with Tabs3 General Ledger System (GLS) and/or Tabs3 Billing, you will see
additional data entry windows for entering GLS journal entries and Tabs3 cost entries when you
enter the invoice, similar to the following figures (Figure 6 and Figure 7).

[ CostEntry [= ][5 s
Client: 121.01 w  Phillips/Marcus o
Real Estate Acquisition
Reference: 57 v Monthly Source: Accounts Payable
Date: 11/28/2018 | v Monday Primary: 1 Michael L. Jensen
Tcode: 102 ¥ CF Normal Advance
Units: Rate: 0.000 Amount:

Description:  |Courier fee (200) United Parcel Service

Spal

Timekeeper: ¥ Michael L. Jensen
Bill Code: 0 - Billable / Printable v Status: |P - Print A
Rate Code: |E| v Default Sales Tax: |0 - Nontaxable w
| Invoice Amount: 75.00 Remaining Amount: 0.00
Client ID Ref & Date Amount Description A
IEETE -

Figure 6, Tabs3 Cost Entry window

-10-
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[ invoice/Manual Check Entry

(=[O ]Es)
[
Invoice/Manual Check General Ledger
Vendor: 200 United Parcel Service
Reference: 5

5
Invoice Total:  75.00

Remaining Amount:  0.00
GLS Account Account Description

Journal  Journal Description Amaount
0.00 Save
Account  Description Jml Name Amount A add
n Disbursements
Delete

Figure 7, General Ledger (GLS) Journal Entry tab

Note: Additional information regarding integration can be found in APS Help and the
Integration Guide.

11 -
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Verification Lists

Upon closing the Invoice/Manual Check program, you will be prompted to print a verification list.
Verification lists are used to track all records that have been added, changed, or deleted per User ID.
This list makes it easy to keep an audit trail of which invoices, manual checks, and/or EFTs have been
entered. If you are integrating with Tabs3 General Ledger Software, journal entries will be included as
well. Click OK and follow the printer prompts in order to generate a verification list.

Date: 11/28/2018 APS Invoice/Manual Check Verification List Page: 1
Jensen, Martin & Anderson, P.C
User: CATHY Cathleen Trudore
Ref Vendor  Voucher Invoice Entry v Due inv Disc Disc Take  Bank
Num Number Number Number Date Date Date Amount Amount Date Disc Acct HIP
3 200 3243387 11/28/2018  11/28/2018  11/28/2018 75.00 1 P
Check: 25658 Amount: 75. Date: 11/28/2018
Overnight document delivery
Name:  United Parcel Service
GLS Acct:  1210.00 Advanced Client Costs Journal 1 Amt 75.00
Invoices
Total Amount: 000  Total Discount: 0.00
Manual Checks
Total Amount: 75.00  Total Discount: 0.00 Total Paid: 75.00
Vendor Checksum = 1,096
Changed Entries
New
2 700 AUTO 11/18/2018  11/28/2018  11/24/2018 750.00 1 P
Monthly Cleaning Charges (Bi-Weekly Service)
Name:  Clean All Janitorial Services
GLS Acct:  8040.00 Office Supplies Journal 3 Amt 750.00
old
2 700 AUTO 11/18/2018  11/28/2018  11/24/2018 750.00 1 P
Name:  Clean Al Janitorial Services
Total Transaction Count = 2

Figure 8, Invoice/Manual Check Verification List

-12-
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Printing Checks

Checks can be individually printed from the Invoice/Manual Check program, or in batches from the
Print Checks program.

Printing from the Invoice/Manual Checks Program

Menu: File | Open | Invoice/Manual Checks | Quick Print
Home: All Actions | Invoices | Invoice/Manual Check Entry | Quick Print

The Quick Print feature is available when entering an invoice from the Invoice/Manual Check
window. Quick Print allows you to print a check without leaving the data entry window. When an

invoice is entered with an amount, clicking the Quick Print b tton on the Invoice Data Entry
toolbar lets you print a check for the selected invoice.

Invaice/Manual Check Entry i
‘ = Quick Print !E {
L

Invoice/Manual Check General Ledger J

&

Vendar: | 700 !

L il R ,_.._--—_J

Figure 9, Invoice/Manual Checks
Quick Print

Printing from the Print Checks Program

Menu: Checks | Print Checks
Home: All Actions | Checks | Print Checks

The Print Checks program is used to process checks for unpaid invoices. You can set a beginning
check number and print unlimited test patterns before printing checks.

13-
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& Print Checks & Print Checks

Vendor Invoices Options

Beginning Vendor Mumber: l:l v Multiple...

Vendar Invoices  QOptions

EBank Account: l:l @ Thru: I:l @
Invoice Date: mmy/ddyyyy | v Thru: | mm/ddfyyyy | v
Due Date: mmy/ddyyyy | v Thru: | mm/ddfyyyy | v

Ending Vendor Number:

I
Beginning Mame Search: l:l

M ool P s il s s A T e
e it i, it sl e i, e ot i et S

Ending Name Search: mm/dd/yyyy Thru: | mmy/dd/yyyy
wendor Order Include Woucher # ‘ | Thru: | |
® Numeric Inactive Vendors
O Alpha
Figure 10, Print Checks - Vendor tab Figure 11, Print Checks - Invoices tab

WX Print Checks

vendor Invoices Options

Check Date: 11/26/2018 | v

Select Invoices to Print

[JExclude Invoices with Unpaid Tabs3 Cost Transactions

e i o e i, e Ml i, A

Figure 12, Print Checks - Options tab

Vendor tab The Vendor tab allows you to select vendors by their
vendor number or the value entered in the Name Search
field. You can also specify whether checks should print in
numeric or alphabetical order. To print checks for all
vendors, leave the values on this tab blank.

Invoices tab The Invoices tab allows you to select invoices by
specifying ranges of bank accounts, invoice dates, due
dates, and voucher numbers. Leaving the values blank will
allow you to print all unpaid invoices regardless of date.

-14-
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Options tab The Options tab allows you to select the date to print on

the checks. The Check Date will be used as the Date Paid
in the Invoice/Manual Checks file. The Check Date will
also be used for the GLS journal entry date if integrating
with GLS.

The Select Invoices to Print check box on the Options tab
allows you to view a list of all invoices that are eligible for
printing prior to processing (Figure 13). This feature allows
you to select specific invoices for which to print checks,
which is particularly useful when only a single check must
be printed at a time when checks typically aren’t
processed.

The Exclude invoices with Unpaid Tabs3 Cost
Transactions check box on the Options tab allows you to
prevent checks from printing for invoices with Tabs3 costs
if the cost is unpaid. Selecting this check box makes it
possible to not pay invoices for advanced client costs until
the client has paid the firm.

Select Invoices

+  Bank Vendor # Name

(V| 1] 202 Sofmere Techr

v 1 204 Clerk of the Dist 150.00 Marmiage Filing Fee
v 1 250 D& B Real Estz KEY 1141322018 10.00 10.00 - Duplicate Key for building

Vv 1 400 Sprint Local & L 4023107600 11/20/2018 68.96 BB.96 - Nawernber Cell Phone Charges

Invoices Selected:

4 Total Amount to Pay Selected: 433.96

Cancel Select All Clear all

Figure 13, Print Checks - Select Invoices to Print window

-15-
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Posting Checks and EFTs

Menu: Checks | Post Invoices/Checks | Post Checks/EFTs
Home: All Actions | Checks | Post Checks/EFTs

The Post Checks/EFTs program is used to post check and EFT information to the appropriate files.
Running the Post Checks program creates Tabs3 General Ledger journal entries when Accounts
Payable is integrated with GLS. The Post Checks/EFTs program can be run as often as desired, but is
typically run once a month.

 Post Checks/EFTs = e
Last Posting Cut-Off Date: 11/28/2016
Posting Cut-Off Date: 11/26/2018 | w
Total Processed Errors Progress
Vendors

Invoices

Warning: It is important to back up your GLS data prior to running this
program. If the posting process is interrupted for any reason, it
will be necessary to restore your data and rerun this program.

o | [ ]

Figure 14, Post Checks/EFTs window

» To post checks and EFTs

1. From the APS menu, click the Checks menu, highlight Post Invoices/Checks, and then select
the Post Checks/EFTs option.

2. Enter the desired Posting Cut-Off Date.

3. Click OK. A progress monitor showing the total number of vendors and invoice entries will
be displayed along with the current vendor and invoice entry being posted.

-16-
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Voiding Checks and EFTs

Once a check has been printed or posted, it cannot be edited or reprinted without being voided.
There are two programs available for voiding checks: Void/Reprint Unposted Checks and Void
Posted Checks/EFTs.

Void/Reprint Unposted Checks

Menu: Checks | Void Checks | Void/Reprint Unposted Checks
Home: All Actions | Checks | Void or Reprint an Unposted Check

The Void/Reprint Unposted Checks program allows you to void unposted checks or reprint
unposted checks that have already been printed or were interrupted during the printing process.
Invoices and manual checks can be voided. This program does not allow you to void or reprint
checks that have already been posted.

L'E Void/Reprint Unposted Checks EI@

Bank Account: I:‘ v

Check #

!

(® Reprint Check O Void Check
Check Date: < Delete invoices paid by the check

i

Mew Check #:

Figure 15, Void/Reprint Unposted Checks

Void Posted Checks and EFTs

Menu: Checks | Void Checks | Void Posted Checks/EFTs
Home: All Actions | Checks | Void Posted Checks/EFTs

The Void Posted Checks/EFTs program allows you to void posted invoices, including posted manual
checks and EFTs. The Void Posted Checks/EFTs program will back out a paid invoice from the vendor
totals. If you are integrating with GLS, reversing General Ledger journal entries are automatically
created and posted to GLS.

-17-
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_- Void Posted Checks/EFTs

[=]@

Vendor: v  United Parcel Service
Bank Account: l:l v

Type: @® Check COFEFT

Check =: I:l ¥ [JDelete invoices paid by the check

Figure 16, Void Posted Checks

- 18-
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Additional Resources

Help

The Help contains detailed information on all features of the software. The Help is accessible by
pressing F1 from anywhere within the software; doing so will load the Help information for the
particular topic being accessed.

Knowledge Base

Tabs3's extensive Knowledge Base is available 24 hours a day, 7 days a week. The Knowledge Base
can be accessed from within the software by selecting Help | Internet Resources | Knowledge
Base.

o R11104 - "Tabs3 Accounts Payable (APS) Frequently Asked Questions” contains answers to
commonly asked questions regarding Tabs3 Accounts Payable Software.

All Knowledge Base articles are available on our website at:

support.Tabs3.com

Report Pack

The Accounts Payable Report Pack provides detailed descriptions, definitions, and examples of
reports provided with the Accounts Payable Software. This is a useful reference for anyone looking
to better understand the reporting features included with the software.

All guides and report packs are available on our Web site at:

Tabs3.com/support/docs.html

-19-
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